Operating instructions
Groundwater Datalogger
OTT ecolog 500

OTT ecolog 500 3G

OTT




These operating instructions cover the groundwater dataloggers

OTT ecolog 500
OTT ecolog 500 3G

The following naming conventions are used to distinguish between the different
device variants within the description:

OTT ecolog 500 (3G) — applies to both device variants
OTT ecolog 500 — applies to OTT ecolog 500 only
OTT ecolog 500 3G~ — applies to OTT ecolLog 500 3G only

These operating instructions (version "05-1016") cover the OTT ecolog 500 (3G)
software versions

OTT ecolog 500 firmware: ~ V 1.03.5
OTT ecolog 500 3G firmware: V 1.00.0
OTT Water Logger Operating Program: V 1.70.0 and later

The OTT ecolog 500 (3G) firmware can be found in the "Advanced operation”
mode, "OTT ecolog 500 (3G)" window of the operating program. The version of
the operating program can be found via the "Info" function in the "Help" menu.

We reserve the right to make technical changes and improvements without notice.
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1 Scope of supply

OTT ecolog 500

OTT ecolog 500 3G

2 Order numbers

OTT ecolog 500

OTT ecolog 500 3G

Accessories !

- 1 groundwater datalogger consisting of a communication unit with built-in
GSM/GPRS cellular modem, pressure probe cable with pressure compen-
sation capillary and Kevlar core for longitudinal stabilization, 2 desiccant

capsules, and pressure probe with datalogger;

— 1 lithium battery, DD type (26 Ah) or 1 lithium battery, D type (13 Ah); or
2 alkaline batteries (1.5 V), LR14 - AM-2 - MN 1400 - C type, incl. battery holder;

- 1 operating instructions
— 1 factory acceptance test (FAT) certificate

- 1 groundwater datalogger consisting of a communication unit with built-in
GSM/GPRS/UMTS/HSPA+ cellular modem, pressure probe cable with pres-
sure compensation capillary and Kevlar core for longitudinal stabilization,

2 desiccant capsules; pressure probe with datalogger

— 1 lithium battery, DD type (26 Ah); or 1 lithium battery, D type (13 Ah);

- 1 operating instructions
— 1 factory acceptance test (FAT) certificate

Groundwater datalogger

— incl. lithium battery, DD type (26 Ah); or
incl. lithium battery, D type (13 Ah); or
incl. 2 x 1.5V alkaline type (C cell)

Groundwater datalogger
— incl. lithium battery, DD type (26 Ah)
incl. lithium battery, D type (13 Ah)

Required ordering information

- Measuring range:  0...4/10/20/40/100 m
- System length: 2...200 m (1 % +5 cm)

— Temperature sensor: calibrated/not calibrated

Adapter plates

for OTT top caps with cut-out

—3"

—4"

45"

— 5

—4"

Universal suspension bracket

for top caps from 3" upwards, without cut-out
as well as for universal installation

"OTT Water Logger Software CD-ROM"
OTT Water Logger Operating Program for PC, and
OTT ecolog 500 (3G) operating instructions (PDF file)

External radio antenna
cable length: 0.5 m
cable length: 1.0 m
cable length: 1.5 m

5-sided key
for locking OTT top caps

Optical OTT Duolink reading head
Optical reading head OTT IrDA link USB

1) Additional accessories — e.g. plastic top caps, top caps with external or internal radio antenna on request

55.446.001.9.0
55.446.002.9.0
55.446.005.9.0

55.448.001.9.0
55.448.002.9.0

55.446.022.9.2
55.446.023.9.2
55.446.024.9.2
55.446.025.9.2
55.446.026.9.2

55.446.021.9.2

56.572.002.9.7

97.980.062.9.5
97.980.061.9.5
97.980.060.9.5

20.250.095.4.1

55.520.017.4.2
55.520.026.9.2



Spare parts/
Consumables

Lithium battery, DD type (26 Ah)
Lithium battery, D type (13 Ah)

Battery holder" for
2 alkaline batteries (1.5 V), batteries not included

Alkalinebatteries!), 2x
LR14 - AM-2 - MN 1400 - C type.

Desiccant capsules
2x in aluminum bags

1 for OTT ecolog 500 (not usable for OTT ecolog 500 3G)

97.800.011.9.5

97.800.009.9.5

55.446.020.9.2

96.800.003.9.5

97.100.296.9.5



3 Basic safety information

Read these operating instructions before using the OTT ecolog 500 (3G) for
the first time! Become completely familiar with the installation and operation of
the OTT ecolog 500 (3G) and its accessories! Keep these operating instructions
for later reference.

The OTT ecolog 500 (3G) is designed to measure groundwater levels and
temperature and to transmit these measured values through a GSM cellular
network. Only use the OTT ecolog 500 (3G) as described in these operating
instructions! For further information — refer to Chapter 4, "Introduction".

Please note all safety and warning information given within the individual work

steps. All safety and warning information given in these operating instructions

are marked by the following adjacent warning signals:

- Black warning triangle — warning of potential damage fo the unit,
reduced functionality and particularly noteworthy points.

- Black warning triangle with yellow background — there is a
health hazard! Detailed information on the hazard including information on
how to prevent the hazard and possible consequences of non-observance.

Ensure the electrical, mechanical, and climatic specifications listed in the
technical data are adhered to.
For further information — refer to Chapter 23, "Technical data".

When operating the OTT ecolog 500 (3G), keep a minimum distance of
0.2 metres between radio antennae and

- people, as well as

— other electrical equipment/antennae

Handle the pressure probe cable with care. Do not kink the cable or pull it
across sharp edges!

Do not make any changes or retrofits to the OTT ecolog 500 (3G)! If changes
or retrofits are made, all guarantee claims are voided.

Have a faulty OTT ecolog 500 (3G) inspected and repaired by our repair
center. On no account carry out repairs yourself!
For further information — refer to Chapter 21, "Repair”.

After putting the unit out of service, properly dispose of the OTT ecolog 500 (3G).
On no account put the OTT ecolog 500 (3G) into the normal domestic waste. For
further information — refer to Chapter 22, "Note about the disposal of used units".

CAUTION
Hot device surface at higher ambient temperatures!

The metal parts of OTT ecolog 500 (3G) device surface can get very hot at
higher ambient temperatures). This may lead to burns.

Use protection gloves during installation and maintenance at higher
ambient temperatures!!

1) > approx. 60 °C / 140 °F

Federal Communications Commission (FCC) Approval

Note: This equipment has been tested and found to comply with the limits for a Class
A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful inferference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications. Opera-
tion of this equipment in a residential area is likely to cause harmful inferference in
which case the user will berequired fo correct the interference at his own expense.

Industry Canada Approval

This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme & la norme NMB-003 du
Canada.



4 Introduction

The OTT ecolog 500 (3G) groundwater datalogger is designed to precisely mea-
sure and store groundwater levels and temperature and to transmit these mea-
sured values through a GSM cellular network.

The pressure probe equipped with a relative pressure probe cell uses the hydro-
static pressure of the water column to determine the water level. As a reference, a
pressure compensation capillary in the pressure probe cable provides the measur-
ing cell with the current ambient air pressure. Erroneous measurement results due
to atmospheric air pressure fluctuations are thus eliminated.

The OTT ecolog 500 (3G) is available in five measuring ranges:

0... 4 mwater column (O ... 0.4 bar)
0 ... 10 m water column (O ... 1 bar)
0 ... 20 m water column (O ... 2 bar)
0 ... 40 m water column (O ... 4 bar)

0 ... 100 m water column (O ... 10 bar)

Based on a reference value that is input during startup, the OTT ecolog 500 (3G)
default setting provides measurement results in the form of depth values. Alterna-
tively, levels or pressure values are possible. The measurement intervals (sample
intervals) can be preselected as necessary.

The operating parameters are set using the "OTT Water Logger Operating Pro-
gram" PC software. This software allows the system to be conveniently and flexibly
tailored to a wide range of measurement requirements of a station. The software
can be set to provide a basic or an advanced user interface. The basic user inter-
face allows dll settings to be adjusted within a single program window. In the
advanced user inferface, the sqmp|e interval can be controlled e.g. by means of
limit events. The software also supports the execution of pumping fests.

The stored measured values are made available through an infrared interface
(IrDA) for wireless readout using PC on which the OTT Water Logger Operating
Program is executed.

The OTT ecolog 500 (3G) includes a built-in cellular modem (with SMA antenna
connector) that is used for remote data transfer and remote parameterizing” via
the cellular network. The remote data transfer can be optionally carried out by
SMS text messages or transmission services GSM, GPRS, UMTS 2 or HSPA+ 2.

If necessary — e.g. when the signal strength of the cellular network is low at the
installation site — the factory installed radio antenna may be replaced by an exter-
nal one.

The OTT ecolog 500 (3G) is installed by simply hanging it into observation wells
of 2" in diameter and above. For this purpose, various adapters/universal suspen-
sion brackets are available as accessories. For power supply, three options are
available: lithium battery, DD type, 26 Ah capacity; lithium battery, D type, 13 Ah
capacity; or commercial alkaline batteries (only OTT ecolog 500 with dedicated
battery holder). When using the DD type lithium battery, battery lifetime is
(depending on additional parameters) at least 10 years, taking into account one
single remote data transfer per day.

The communication unit of the OTT ecolog 500 (3G) can withstand temporary
flooding (for details, refer to Chapter 23, "Technical data").

1 only OTT ecolog 500
2 only OTT ecolog 500 3G



Fig. 1: Setup of a groundwater measure-

ment station using the OTT ecolog 500 (3G).
The OTT ecolog 500 (3G) essentially con-

sists of three components: communication
unit, pressure probe cable, and pressure
probe with datalogger.

OTT ecolog 500 (3G) system length =
length ofcommunication unit + cable length
+ length of pressure probe with datalogger.

(The system length is required when
ordering an OTT ecolog 500 (3G).
When setting the OTT ecolog 500 (3G)
operating parameters, the system length
is not required.)

(The rubber stop attached to the pressure
probe cable prevents the pipe casing from
falling when the communication unit is
open. Do not move the rubber stop!)

System length

...20m,

10m,0
100 m Water column

Measuring ranges:

0..4m,0...
0...40m,0 ...

Depth

Measuring range

=

N

Top cap

Observation well

Communication unit

Rubber stop
(don't move)

Pressure probe
with datalogger

Pressure sensor
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5 Installing, checking, and replacing batteries

WARNING
Improper handling of batteries involves fire or explosion hazard!

Only use the battery types specified (no rechargeable types).

Always use brand-new batteries. Do not mix used and new batteries.

Do not mix batteries from different manufacturers

Do not charge the batteries!

Avoid short circuits!

Avoid mechanical damage!

Do not open batteries!

Do not expose batteries to fire or to temperatures above 100 °C!

Do not solder on the batteries!

Properly dispose of exhausted batteries. Do not put them into domestic waste.

Suitable battery types
OTT ecolog 500

Lithium battery, DD type (26 Ah), (use OTT accessories only); or
Lithium battery, D type (13 Ah), (use OTT accessories only); or

2 alkaline batteries (1.5 V), LR14 - AM-2 - MN 1400 - C type.

For using the alkaline batteries, a dedicated battery holder is required.

OTT ecolog 500 3G
Lithium battery, DD type (26 Ah), (use OTT accessories only); or
Lithium battery, D type (13 Ah), (use OTT accessories only).

Battery lifetimes
The values mentioned below apply to the following conditions: sample interval -
1 hour; one single remote data transfer per day; system length — 50 m.

Lithium battery, DD type : at least 10 years,

Lithium battery, D type :  at least 5 years,

Alkaline batteries: at least 1 year (high quality battery types).

Notes

The OTT ecolog 500 (3G) starts measuring after inserting the batteries (there is
no ON/OFF switch).

If the OTT ecolog 500 (3G) is to be shut off = remove the batteries. This will
prevent the batteries from draining prematurely and will stop any recording of
unusable measurements.

When transporting the OTT ecolog 500 (3G)— remove the batteries. This will
prevent the batteries from draining prematurely and will stop any recording of
unusable measurements.

When bringing the unit back into operation, it takes — dependent on how much
data is stored — up to 7 minutes until the OTT ecolog 500 (3G) starts measuring
again.

1 for OTT ecolog 500 (not suitable for OTT ecolog 500 3G)



Check the battery voltage as follows

Establish the PC/OTT ecolog 500 (3G) communication link,

refer to Chapters 9.2 or 9.3.

Select the "OTT ecolog 500 (3G)" menu, "View Instantaneous values" function !
— The OTT ecolog 500 (3G) starts an instantaneous value measurement — The
"Observer" window indicates the current battery voltage and the energy drawn
from the batteries so far in Ah.

Alkaline batteries?: Criterion for replacing the batteries:

Battery voltage lower than about 1.9 V — Replace the batteries.

Lithium batteries: Criterion for replacing the batteries: Ah drawn

Lithium battery, DD type: > approx. 20 Ah

Lithium battery, D type : > approx. 10 Ah

— Replace the batteries.

(For technical reasons, the bqﬂery vo|tdge disp|ayed cannot not be used as a
criterion for replacing the batteries.)

Click on the "Exit" button.

Close the operating program.

1) With suitable settings (Menu "File", function "Options"), the operating program starts with the
"Observer" window.

2 for OTT ecolog 500 (not suitable for OTT ecolog 500 3G)



5.1 Power supply using lithium batteries

How to insert the lithium battery

Remove the screw fitting from the communication unit.
Slide the cap and pipe casing of the communication unit approx. 50 cm
towards the pressure probe cable.

Fig. 2: Setup of the OTT ecolog 500 (3G)

communication unit.

Infrared interface

Radio antenna

SIM card slot

Battery compartment

Communication unit

desiccant unit o _
Communication unit

Pressure probe |

desiccant unit

—— Pipe casing

Cap of the

communication unit

Rubber stop

Pressure probe cable
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Connect the lithium battery plug to the socket of the electronic unit, as shown in
figure 3.

Fig. 3: Inserfing the lithium battery.

L

;
Lithium battery, DD type \/
)
;

Velcro strip Battery compartment Electronic unit

Open the Velcro strip of the battery compartment.

Insert the lithium battery into the battery compartment (D type lithium battery:
insert the battery into the right-hand side (top) of the battery compartment; the
wiring of the D type lithium battery below the heat-shrinkable tubing must be
located at the side or bottom.)

Firmly close the Velcro strip around the lithium battery.

Slide the cap and the pipe casing of the communication unit back up to the
stop. Please note: Do not bend or pinch the battery lead.

Reinstall the screw fitting to the communication unit.

13



How to replace the lithium battery

Open the top cap/observation well cover.

Pull and hold the communication unit approximately 1 m out of the observation
well (a second person would be useful).

Remove the screw fitting from the communication unit.

Slide the cap and pipe casing of the communication unit approx. 50 cm
towards the pressure probe cable. (The rubber stop located on the pressure
probe cable (refer to Fig. 2) prevents the pipe casing from falling. Do not move
the rubber stop!)

Disconnect the lithium battery plug from the socket of the electronic unit, while
pressing the connector latch.

Open the Velcro strip of the battery compartment.

Remove the exhausted lithium battery and make sure not to pull the lead!
Within 10 minutes, connect the lithium battery plug to the socket of the elec-
tronic unit, as shown in figure 3.

Insert the lithium battery into the battery compartment (D type lithium battery:
insert the battery into the right-hand side (top) of the battery compartment; the
wiring of the D type lithium battery below the heat-shrinkable tubing must be
located at the side or bottom.)

Firmly close the Velcro strip around the lithium battery.

Slide the cap and the pipe casing of the communication unit back up to the
stop. Please note: Do not bend or pinch the lithium battery lead.

Reinstall the screw fitting to the communication unit.

Slowly and carefully reinsert the communication unit into the observation well.
Delete the power consumption value (power drawn from battery in ampere
hours) in the "Observer" window of the operating program. For more infor-
mation, please refer to online help in the operating program.

Close the top cap/observation well cover.

Notes

The OTT ecolog 500 (3G) stores the measured values in a non-volatile memory.
There is no loss of data when changing batteries.

This also applies to storage without batteries for a long period.

If replacing the batteries takes longer than approx. 10 minutes the time (and
possibly the date) will have to be re-entered, refer to Chapter 15, "Setting date
and time". Furthermore, it takes — dependent on how much data is stored — up
to 7 minutes until the OTT ecolog 500 (3G) starts measuring again (during this
time, the OTT ecolog 500 (3G) re-initializes its database).

When replacing the batteries, we recommend changing the desiccant capsules
at the same time, refer to Chapter 18.2, "Replacing the desiccant capsules”.



Fig. 4: Inserting alkaline batteries
into the battery holder.

5.2 Power supply using alkaline batteries (OTT ecolog 500)

Notes

Alkaline batteries can only be used in the OTT ecolog 500.

They cannot be used in the OTT ecolog 500 3G!

At 0 °C, alkaline batteries have approx. 50 % of their original 20 °C capacity
and at =10 °C, they have approx. 35 % due to their design. If temperatures
drop below 0 °C at the measurement station it is recommended that lithium
batteries (OTT lithium batteries D or DD types) be used.

How to insert the alkaline batteries into the battery holder

Remove the screw fitting from the communication unit.

Slide the cap and pipe casing of the communication unit approx. 50 cm
towards the pressure probe cable.

Open the Velcro strip above the battery holder.

Remove the battery holder from the battery compartment.

Remove the cap of the battery holder by rotating it counter-clockwise.
Insert 2 alkaline batteries (LR14 - AM-2 - MN 1400 - C) info the battery
holder as shown in figure 4. Ensure that the polarity is correct!

Velcro Sh’i/) Electronic unit

TR

Battery holder
cable

N/ \
Alkaline battery

(LR14 - AM-2 - MN 1400 - C) Battery holder

Install the cap of the battery holder by rotating it clockwise.

Insert the battery holder into the battery compartment.

Firmly close the Velcro strip of the battery holder around the battery holder.
Slide the cap and the pipe casing of the communication unit back up to the
stop. Please note: Do not bend or pinch the battery holder lead.
Reinstall the screw fitting to the communication unit.

15
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How to replace exhausted alkaline batteries

Open the top cap/observation well cover.

Pull and hold the communication unit approximately 1 m out of the observation
well (a second person would be useful).

Remove the screw fitting from the communication unit.

Slide the cap and pipe casing of the communication unit approx. 50 cm
towards the pressure probe cable. (The rubber stop located on the pressure
probe cable (refer to Fig. 2) prevents the pipe casing from falling.

Do not move the rubber stop!)

Open the Velcro strip above the battery holder.

Remove the battery holder from the battery compartment.

Remove the cap of the battery holder by rotating it counter-clockwise.
Remove the exhausted alkaline batteries and make sure not to pull the lead!
Within 10 minutes, insert 2 alkaline batteries (LR14 - AM-2 - MN 1400 - C)
into the battery holder as shown in figure 4 (ensure that the polarity is correct)
an install the cap of the battery holder by rotating it clockwise.

Insert the battery holder into the battery compartment.

Firmly close the Velcro strip of the battery holder around the battery holder.
Slide the cap and the pipe casing of the communication unit back up to the
stop. Please note: Do not bend or pinch the battery holder lead.

Reinstall the screw fitting to the communication unit.

Slowly and carefully reinsert the communication unit into the observation well.
Close the top cap/observation well cover.

If you want fo change from the current|y used boﬁery holder containing 2 alkaline
batteries (LR14 - AM-2 - MN 1400 - C) to lithium batteries prior to using the unit
follow the steps below:

Disconnect the battery holder cable from the socket of the electronic unit.
Carefully pull the plug straight upwards.

Open the Velcro strip above the battery holder.

Remove the battery holder from the battery compartment.

Insert the lithium battery as described in Chapter 5.1.

Notes

The OTT ecolog 500 (3G) stores the measured values in a non-volatile memory.
There is no loss of data when changing batteries.

This also applies to storage without batteries for a long period.

If replacing the batteries takes longer than approx. 10 minutes the time (and
possibly the date) will have to be re-entered, refer to Chapter 15, "Setting date
and time". Furthermore, it takes — dependent on how much data is stored — up
to 7 minutes until the OTT ecolog 500 (3G) starts measuring again (during this
time, the OTT ecolog 500 (3G) re-initializes its database).

When replacing the batteries, we recommend changing the desiccant capsules
at the same time, refer to Chapter 18.2, "Replacing the desiccant capsules".



6 Inserting a SIM card

For communicating over the cellular network, a SIM card is required.

(OTT ecolog 500: type Mini-SIM card; OTT ecolog 500 3G: type Micro-SIM card)

How to insert the SIM card:

Remove the screw fitting from the communication unit.

Slide the cap and pipe casing of the communication unit approx. 50 cm
towards the pressure probe cable, refer to Fig. 2.

Temporarily disconnect/remove batteries (refer to Sections 5.1 and 5.2).

Make sure not to touch the gold-colored contacts of the SIM card!

— OTT ecolog 500: Insert the SIM card into the SIM card slot as shown in
Fig. 5: press bevelled edge against the latch so that the latch slightly moves to
the left allowing the SIM card to engage.

— OTT ecolog 500 3G: Insert the SIM card into the silver-coloured SIM card
slot (with the bevelled edge pointing left) until you hear it clicking into place.

Make sure that the SIM card is fully inserted and engaged!

Fig. 5: Inserfing the SIM card.

This figure shows, as an example,
a mini-SIM card being inserfed into
the OTT ecolog 500.

SIM card slot

—— SIM card

Reconnect/insert batteries (refer to Sections 5.1 and 5.2).

Slide the cap and the pipe casing of the communication unit back up to the
stop. Please note: Do not bend or pinch the battery lead.

Reinstall the screw fitting to the communication unit.

Changing/removing the SIM card

— OTT ecolog 500: Slide the latch into the direction indicated by the arrow.
— OTT ecolog 500 3G: Press the SIM card approx. 1 mm further into the
SIM card slot before letting go.
The SIM card will then be ejected a few millimeters and can easily be pulled out.

17



Fig. 6: Connecting an external
radio antenna.

7 If required: Connecting an external radio antenna

If the local signal strength of the cellular network prevents transmitting from the

closed observation well, an external radio antenna (accessory) is to be connected
to the OTT ecolog 500 (3G). In this case, only the dedicated external radio antenna
specified by OTT must be used for this particular application (cable length max.3 m).

You may fasten the external radio antenna to a suitable location using the shim
and nut supplied (drilling a hole for the thread of the external antenna is required:
@ approx. 18 mm). For this installation, an individual solution to fasten the exter-
nal antenna must be found depending on the station.

If the observation well is closed by a top cap you need to have a hole in the
observation well so that the antenna cable can be routed to the outside (to prevent
rain water from entering into the observation well, it is recommended to place the
hole on the side). If required seal the cable feedthrough.

How to connect an external radio antenna

Depending on the particular local situation (diameter of the observation well, type
of the top cap, and other mounting characteristics), the external radio antenna
must be connected prior to or during installation. Please note the relevant chapters

8.2 through 8.4.

quefu”y unscrew the chtory mounted antenna by hand.

Route the plug of the antenna cable through a hole in the observation well.
Connect the plug to the antenna socket and hand-tighten the locknut.
Fasten the external radio antenna to a suitable location outside the
observation well.

Radio antenna

External radio antenna

L. P|ug of external radio antenna
Communication \
unit Antenna socket

)

Note

When installing an external radio antenna, the minimum distance to people
and other electrical equipment or antennae must be at least 20 cm.
Additional accessories for optimizing the radio conditions at the station are
available on request (e.g. plastic top caps, top caps with external or internal
radio antennal).



8 Installing the OTT ecolog 500 (3G) unit

The OTT ecolog 500 (3G) is installed by hanging it into the observation well.
The necessary accessories and type of installation vary depending on the diameter
of the observation well and the design of the top cap:

2" observation wells refer to 8.1
OTT top cap with cut-out for adapter plate
4" or 6" observation wells, refer to 8.2
OTT top cap with cut-out for adapter plate
Observation wells of 3" in diameter and above, refer to 8.3
Top caps without cut-out for adapter plate
Special case: observation wells beginning at 3" in diameter refer to 8.4

without top cap, universal installation

Fig. 7: Accessories for installation — Part 1

1 = drilled hole for OTT ecolog 500 (3G) 6" adapter plate
2 = cut-out for screws of the top cap
3 = cut-out for contact gauge

(Each adapter plate consists of two parts
and three bolts. In the figure, the adapter
plates are shown in installed condition (on
delivery, they are not installed). Further-
more, an O-ring is supplied with the
adapter plates.

4" adapter plate

3" adapter plate

19



Fig. 8: Accessories for installation — Part 2

1 = drilled hole for OTT ecolog 500 (3G)

Fig. 9: Installing the OTT ecolog 500 (3G)

into a 2" observation well.

20

Universal suspension bracket e

8.1 Installing the unit into 2" observation wells,

top cap with cut-out

Required accessories: 2" OTT top cap with cut-out

How to install the OTT ecolLog 500 (3G)

Preliminary work: If not already done, install batteries and SIM card,

refer to Chapter 5.

Open the top cap.

Defermine the current depth using a contact gauge and note the measured
value.

Insert the pressure probe into the observation well.

Slowly and carefully lower the pressure probe by means of the pressure
probe cable!

Insert the communication unit into the observation well until the upper part of
the communication unit is fully seated on the top cap, refer to Fig. 9.

Set the operating parameters, refer to Chapter 9.

Close the top cap.

—— OIT top cap

Communication unit

Infrared interface

———— 2" observation well




Fig. 10: Install the adapter plate to the
upper part of the communication unit.

Example: 4" observation well.

8.2 Installing the unit into 3", 4" or 6" observation wells,
top cap with cut-out for adapter plate

Required accessories: OTT top cap with appropriately sized cut-out and
compatible adapter plate (incl. O-Ring).

How to install the OTT ecoLog 500 (3G)

Preliminary work: If not already done, install batteries and SIM card,

refer to Chapter 5.

Put the O-ring over the upper part of the communication unit and slide 20 mm
down.

Slide the lower part of the adapter plate (horseshoe-shaped) below the commu-
nication unit over the pressure probe cable and, on the communication unit,
slide it up horizontally until it touches the O-ring.

Slightly tilt the lower part of the adapter plate and, while rotating it, slide it up
over the O-ring.

Slide the O-ring and the lower part of the adapter plate up until the O-ring is
seated in one of the grooves provided for it.

Assemble the required upper part of the adapter plate (3", 4", or 6") as shown
in Figure 10 with the lower part using three M 2.5 socket head bolts.

Open the top cap.

3" observation wells: Determine the current depth using a contact gauge and
note the measured value.

Insert the pressure probe into the observation well.

Slowly and carefully lower the pressure probe into the observation well
with the pressure probe cable, refer to Fig. 11!

Insert the communication unit with adapter plate assembled into the obser-
vation well until the adapter plate and the upper part of the communication
unit are fully seated on the top cap. Align as shown in Figure 12.

4" and 6" observation wells: Use a contact gauge to determine the current depth
and record it (in the adapter plate, there is a cut-out for the contact gauge).

Set the operating parameters, refer to Chapter 9.

Close the top cap.

%\ Socket head bolt (x3)

" Adapter plate

upper part
(example: 4")
Adapter p|ofe Communication unit
lower part upper part
TT~— |
— |
[ ——O-Ring
\
’ | Communication unit
Note

As an alternative to the procedure described above, you may install the
adapter plate independently of the communication unit. In this case, you have
to feed the pressure probe through the O-ring and the hole in the adapter plate
and to pull the entire pressure probe cable.
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Fig. 11: Feed the communication unit and

Fig.
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adapter plate into the observation well.

12: Installing the OTT ecolog 500 (3G)
into a 3", 4" or 6" observation well.

Example: 4" observation well.

ﬁ/Communicoﬁon unit
Adapter plate ————

Top cap

upper part

Cut-out for
QOTT ecolog 500 (3G)

Communication unit

Pressure probe cable

| Pressure probe

4" adapter plate

N OTT top cap

Cut-out for
contact gauge

upper part




8.3 Installing the unit into observation wells of 3" in diameter
and above, top cap without cut-out for adapter plate

For this installation case, an individual solution to fasten the OTT ecolog 500 (3G)
must be found depending on the station. Example: fix the universal suspension
bracket using an Mé hex head bolt/hex nut laterally to the upper end of the observa-
tion well.

Required accessories: universal suspension bracket, mounting bolts, e.g.: Mé
hex head bolt, washer, and Mé hex nut (all made of stainless steel).

How to install the OTT ecolog 500 (3G)

Preliminary work: If not already done, install batteries and SIM card,

refer to Chapter 5.

Open the top cap.

Drill 2 holes (& 6.5 mm, 20 mm apart) laterally into the upper end of the
observation well.

Please note: The universal suspension bracket is to be mounted in such a
way that there is a gap of a few millimeters between the top cap and the
infrared inferface with the top cap closed. Otherwise there will be a risk of
damaging the infrared interface when the top cap is closed, refer to Fig. 14.
Attach the universal suspension bracket to the observation well using two M6
hex head bolts, washers, and Mé hex nuts. Use the two lower of the three
drilled holes of the universal suspension bracket, refer to Fig. 13.

Pass the pressure probe through the cut-out of the universal suspension bracket.
Slowly and carefully lower the pressure probe into the observation well
with the pressure probe cable.

Pass the communication unit through the holes of the universal suspension
bracket until the communication unit is seated on the universal suspension
bracket, refer to Fig. 14.

Determine the current depth using a contact gauge and note the measured
value.

Set the operating parameters, refer to Chapter 9.

Close the top cap.

Note

If protection against vandalism is required M6 threads are to be tapped into
the observation well instead of mounting the unit by means of hex nuts.
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Fig. 13: Mounting diagram for universal
suspension brackets in observation wells
of 3" and above.

Example: 4" observation well

Minimum clearance (A) of the upper
hole to the upper edge of the opened
top cap: 43 mm!

Fig. 14: Installing the OTT ecolog 500 (3G)
into observation wells of 3" diameter and
above with a top cap without cut-out.

Example: 4" observation well.
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Fig. 15: Mounting diagram for universal
suspension brackets in observation
wells of 3" and above.

Example: 4" observation well

If required, you may fix the universal sus-
pension bracket reversed by 180° as well.
The socket head bolts will then be easily
accessible. In small diameter observation
wells, you may not be able to place the
optical reading head on the infrared inter-
face when establishing a communication
link. In such a case, position the reading
head in a maximum distance of 25 cm
above the infrared interface.

8.4 Installing the unit into observation wells of 3" in diameter
and above, without top cap, universal installation

For this installation case, an individual solution to fasten the OTT ecolog 500 (3G)
must be found depending on the station. Example: fix the universal suspension
bracket using an Mé hex head bolt/hex nut laterally to the upper end of the
observation well.

Required accessories: universal suspension bracket, mounting bolts, e.g.: Mé
hex head bo|fs, wc:shers, and Mé hex nuts (a|| made of stainless stee|).

How to install the OTT ecoLog 500 (3G) (example)

Preliminary work: If not already done, install batteries and SIM card, refer to
Chapter 5.

Drill 2 holes (& 6.5 mm, 40 mm apart) laterally into the upper end of the
observation well, refer to Fig. 15.

Attach the universal suspension bracket to the observation well using two Mé
hex head bolts, washers, and M6 hex nuts. Use the uppermost and lowermost
of the three drilled holes of the universal suspension bracket, refer to Fig. 15.
Pass the pressure probe through the cut-out of the universal suspension bracket.
Slowly and carefully lower the pressure probe into the observation well
with the pressure probe cable.

Pass the communication unit through the holes of the universal suspension
bracket until the communication unit is seated on the universal suspension
bracket, refer to Fig. 14.

Determine the current depth using a contact gauge and note the measured value.
Set the operating parameters, refer to Chapter 9.

Universal
suspension
bracket

\ Cut-out for

OTT ecolog 500
2x drilled hole, @ 6.5 mm \‘\\\ (3G)
40 mm clearance >
‘\\\ Hexagon
o~ bolts

. ),
%
N

Observation
well

Note

If protection against vandalism is required Mé threads are to be tapped into
the observation well instead of mounting the unit by means of hex nuts.
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9 Setting OTT ecolog 500 (3G) operating parameters

To set the OTT ecolog 500 (3G) operating parameters, you will need the "OTT
Water Logger Operating Program" PC software (WBSPLO.exe). This software is
found on the "OTT Water Logger Software" CD-ROM (accessory).

Hardware and software requirements: refer to CD product insert.

9.1 Installing the OTT Water Logger Operating Program

How fto install the OTT Water Logger Operating Program

Insert the OTT Water Logger Software CD-ROM into the PC drive.

In the "\Software\Deutsch" ! directory, start the "setup.exe" file (by e.g. dou-
ble clicking the file symbol) — The Setup Assistant opens and guides you
through the installation.

Follow the installation instructions on the screen.

! Alternatively: change to the "\English", "\Francais", or "\Espafiol" directories.

9.2 Establishing the PC/OTT ecolog 500 (3G) communication link
(on site)

In the following chapters, establishing a communication link between the OTT
ecolog 500 (3G) and a PC is described, which is a pre-requisite for the subse-
quent steps. The following description illustrates the various methods of establish-
ing this communication link.

The communication between the OTT ecolog 500 (3G) and a PC is established
contact-less via invisible infrared light (IrDA interface).

Required accessories:

OTT Duolink reading head 2 or
OTT IrDA-Link USB reading head

2 with PCB version "b": refer to the label on the connection line

How to establish a communication link

Start the operating program.

Change the language for the operating program as required:

press F3 function key (multiple times) until the required language appears.

In the start window, press the "Setup device" button — The operating program
displays the "Basic operation" window. No operating parameters for the

OTT ecolog 500 ( 3G) are visible yet.

— Establishing a communication link to the OTT Duolink reading head:

Connect the OTT Duolink reading head to a serial PC port (COMT, efc.).
Place the OTT Duolink reading head onto the OTT ecolog 500 (3G) infrared
interface, refer to Fig. 16.

In the operating program, select the communication path

"IrDA OTT Duolink" and the serial port used (COM1, ...).



Fig. 16: PC/OTT ecolog 500 (3G)

communication link.

— Establishing up a communication link to the OTT IrDA-Link USB reading head:

Connect the OTT IrDA-Link USB reading head to a USB port on the PC. (USB
interface drivers must be installed, refer to separate installation instructions.)
Place the OTT IrDA-Link USB reading head onto the OTT ecolog 500 (3G)
infrared interface, refer to Fig. 16.

In the operating program, select the communication path
"IrDA OTT IrDA-Link".

Notes

The built-in infrared interface of a PC (standard for many notebooks) can only
be used with the Windows 95 and Windows NT operating systems!

9.3 Establishing the communication link from remote
(OTT ecolog 500)

Note

A remote communication connection can only be established with the
OTT ecolog 500 (not the OTT ecolog 500 3G)!

If both installation and configuration of the OTT ecolog 500 have been completed
the communication link may also be established using the cellular network, e.g.
for future modifications to the configuration. To perform these operations, the PC
on which the operating program is executed must be connected to a wired or
GSM modem. For more information, please refer to online help.

Please note: Establishing a communication link using the cellular network may
take up to a minute!
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9.4 Setting OTT ecolog 500 (3G) operating parameters

How to set the OTT ecolog 500 (3G) operating parameters
Click the "Connect" button (alternatively: menu "OTT ecolog 500 (3G)",

"Connect" function) = The operating program will read the current operating
parameters of the OTT ecolog 500 (3G).

Setting operating parameters, refer to pages 28/29.

Optionally: "Set up cyclic data transmission via SMS" or "Set up cyclic data
transmission via GPRS(/3G)", refer to pages 27/28.

Set date/time: Accept the proposed PC date/time or individually set the
date/time using the "Set date/time" function, also refer to Chapter 15.
Please note: The operating program automatically corrects any Daylight
Saving Time sefting on the PC.

Click the "Save to device" button — "Warning: Reset OTT ecolog 500 (3G)
and delete data memory additionally2" Confirm by clicking "Yes" (recommend-
ed for initial installation and reinstallations).

Please note: All measured values collected so far will be permanently lost!
Check the level of the measured value set (pressure sensor),

refer to Chapter 10.

Remove the OTT DuoLink/OTT IrDA-Link USB reading head.

Close the top cap/observation well cover.
Setting up the cyclic data transmission via SMS ")

Enable the "SMS data transmission active" check box.

If necessary: Enable the "Authorize Roaming " and/or "Store GSM signal
strength" check boxes.

Click the "Settings modem" button — The operating program starts a wizard
for setting all the necessary operating parameters.

Enter the receiver phone no. for the data SMS (phone number of a large
account or for a PC connected to a cellular modem).

Click the "Next" button.

If necessary: enter SIM PIN (4-digit) of the SIM card.

Click the "Next" button.

Set or enter the SMS-C phone no. of the network operator (phone number of
the SMS service center. By default, the SMS-C phone number is already saved
on the SIM card — In this case, set to "SIM card".)

Click the "Next" button.

Select the mode of the SMS transmission.

Click the "Next" button.

Set the interval for transmitting the stored values.

Click the "Next" button.

Set the offset time for the transmission interval.

Click the "Exit" button.

Finally check the settings and correct as necessary.

Click the "OK" button.

! For further information, refer to online help.



Setting up the cyclic data transmission via GPRS(/3G) "

Enable the "GPRS(/3G) data transmission active" check box.

If necessary: Enable the "Authorize Roaming " and/or "Store GSM signal
strength” check boxes.

Click the "Settings modem" button — The operating program opens a window
displaying several tabs for setting all the necessary operating parameters.
Make the required settings in the "General", "Operator", "FTP" and "Time
sync." tabs. Please note: The SIM PIN for the SIM card used should be dis-
abled! Otherwise enter the SIM PIN for advanced operation in the

"Modem/ITC"

tab.

Click the "OK" button.

! For further information, refer to online help.

EDTT ‘Water Logger Operating Program - Basic operation M= E

File Device OTT ecoLogb0l Communication  Help

OTT ecolog 500
Site number IDDDDDE“?EB Site hame IGPHS test

Water level / Pressure Temperature

Parameter number IDDD'I IDDD2
Farameter name I\A-"aler lewel ITemperatur
Meazurement type IWater lenvel j IDepth j
Lt I m [0.07] 'I CnT A

Enter meazured reference walue

o ID,EIEI m [ Depth to water ]
Sanple interval IEI1:DD:EIEI 'I |D1 00:00 'I
Storage interval |D1:DD:DD 'I ID'I 0000 "I
Meazuring range 0-0.4 bar ¥ Modem connected [~ Autharize B oarning
System length 5.00 m [~ 5SK5 data transmizsion active
Date / time 117712001 091241 [PC:17.11.2001 071300 | (] GERG el st calise

Set date/time | [~ Store GSM Signal strength
OTT ecalog BO0 Stored configurations
Connedct | IIrD.-’-‘« -OTT Duolink j Laad from PC |
b ain menu
Advanced operation .. | Save ta device | IEEINH: j IE?EDD j Save to PC |
|Upload successhul [ [

Fig. 17: Setting the OTT ecolog 500 (3G) operating parameters using the OTT Water Logger Operating Program.
The "Advanced operation ..." button is only visible, if the "Advanced operation ..." check box is enabled in the "Options"
window. The figure shows, as an example, the window for setting up the OTT ecolog 500 operating parameters.

OTT ecolog 500 (3G)

Site number
Site name

station number, 10 characters (alphanumeric)
station name, max. 40 characters (alphanumeric)
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Water level/pressure - temperature

Parameter number
Parameter name
Measurement type
Unit +

Decimal places

Depth to water — set new|y
Water level — set newly

Pressure value — set newly
Sample interval

Storage interval

Authorize Roaming

SMS data transmission active
GPRS data transmission active
GPRS/3G data transmission active
Store GSM Signal strength

30

sensor number, 4 characters (alphanumeric)

sensor name, max. 40 characters (alphanumeric)

Water level: depth or level - pressure

— Pressure sensor: m, cm, feet, inch / bar, psi

- Temperature: °C - °F

fixed specification, depending on the units

-m:3or2;cm: 1orO0; feet: 2or 1;inch: 1 or O

—bar: 4 or 3; psi: 3 or 2

-°C:Tor2;°F: lor2

For the "Water level - depth" measurement type: [/] Enter contact gauge value

For the "Water level - level" measurement type: Enter staff gauge value
(reference fo level zero)

For the "Pressure" measurement type: Enter reference pressure

55 ... 24 h: time delay at which the OTT ecolog 500 (3G) records measured val-

ves and stores them (store only, if sample interval = mean interval). The sample

interval is set fo a fixed time pattern (e.g. sample interval of 10 minutes, time pat-

tern ..., 00:10, 00:20, 00:30, ... .

55 ... 24 h: time period for which the OTT ecolog 500 (3G) calculates an arith-

metic mean from the sample interval values and stores it. The storage interval must

be equal to or larger than the sample interval. The sample interval must be con-

tained in the storage interval as an integer number (e.g. sample interval: 10 min-

utes; storage interval: 1 hour — Every hour, the OTT ecolog 500 (3G) stores an

arithmetic mean from 6 sample interval values).

Allows the cellular modem to book into other, external cellular networks (not on|y

into the cellular network specified by the SIM card). This might be of importance

in regions that are located close to a border, in which a foreign cellular network

may have better coverage but is more expensive.

Refer to "Setting up the cyclic data transmission via SMS".

Refer to "Setting up the cyclic data transmission via GPRS(/3G)"; 3G data trans-

mission (UMTS/HSPA+) is only available with the OTT ecolog 500 3G

Stores the GSM signal strength in a separate channel. The sample interval in this

channel is 24 hours (factory sefting: Storage delta = 1); irrespective of this, the

OTT ecolog 500 (3G) saves 1 value per day in any case.



Other displays in the "Basic operation” window

Measuring range Measuring range of the pressure probe, refer to Fig. 1.

System length Cable length including communication unit/pressure probe, refer to Fig. 1.

Date/time Internal date/time of the OTT ecolog 500 (3G).

Battery lifetime (button) The operating program calculates the approximate life of the different battery
types based on the seftings made (at =20 and +20 °C ambient temperature in
each case).

Detailed information on the "Advanced operation" function can be found in the online help.

Factory settings
OTT ecolog 500 (3G)

Site number OTT ecolog 500 (3G) serial number
Site name ecolog 500 1

Water level/Pressure Temperature
Parameter number 0001 0002
Measurement type Water level - depth
Unit m °C
Decimal places 2 1
Sample inferval 1h Th
Storage interval Th Th
Modem connected Enabled
Authorize roaming Disabled
SMS data transmission active Disabled
GPRS(/3G) data transfer active Disabled
Store GSM signal strength Disabled

In addition, the OTT ecolog 500 (3G) records the supply voltage at a sample and storage interval of 1 hour
(refer to online help).
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9.5 Saving/loading an OTT ecoLog 500 (3G) configuration

The "Load from PC" and "Save to PC" functions are designed to archive the

OTT ecolog 500 (3G) configuration on a PC. For example, you may configure
multiple OTT ecolog 500 (3G) units using the same configuration. Additionally,
the "Load from PC" and "Save to PC" functions are required when using the "SMS
command" function (refer to online help).

How to save a configuration

From the "File" menu, select the "Save configuration” function (or use the but-
ton) — The operating program saves the configuration under the name and
number of the OTT ecolog 500 (3G). When changes are made fo a configura-
tion that has already been saved, confirm by clicking "Yes" in the window
"Warning. This configuration name already exists! Replace2" (otherwise, save
the configuration under another station number).

How to load a configuration

From the "File" menu, select the "Load configuration" function

(or use the button).

For an already opened configuration, confirm "Ignore changes?" message by
clicking "Yes" (if necessary, save configuration in advance).

In the "Stored OTT ecolog 500 (3G) configurations" window, select the config-
uration by double-clicking it = The operating program loads the configuration.

9.6 Importing/exporting an OTT ecolog 500 (3G) configuration

To transfer an OTT ecolog 500 (3G) configuration e.g. via USB flash drive or e-
mail, the Import/Export functions are available. Similarly, a configuration can be
sent via the Export function as an XML file to the OTT Hydras 3 user software.
During this process, the OTT Hydras 3 user software creates the entire station/sen-
sor configurations in an OTT Hydras 3 operating range.

Available export/import formats

Export ("BIN" file)
Export to a text file
Export for the OTT Hydras 3 user software

Import ("BIN” file)
The operating program stores all the necessary data of a configuration in a single
"+ BIN", "« TXT" or "* XML" file, depending on the export type.
How to export a configuration ("*.BIN" file)

This export type is required to transfer an OTT ecolog 500 (3G) configuration as
a "*.BIN" file. Using the "Import configuration" function, the configuration can be
read back into the operating program.

From the "File" menu, select the "Export configuration" function.

In the "OTT ecolog 500 (3G) - export configuration" window, edit the file
name, if necessary, select the storage location, and click "Store" — The operat-
ing program saves the configuration in a "*.BIN" file.

Note

The file name of the "+.BIN" file is arbitrary. The operating program suggests a
combination of station number and station name.



How to export a configuration (text file)

This export type is required to transfer an OTT ecolog 500 (3G) configuration for
documentation purposes as a "+.TXT" file. This "+ TXT" file can be opened by
means of any text editor or word processing program.

From the "File" menu, select the "Export text file" function.

In the "OTT ecolog 500 (3G) - configuration" window, edit the file name, if
necessary, select the storage location, and click "Store" — The operating pro-
gram saves the configuration in a "+.TXT" file.

Note

The file name of the "+.TXT" file is arbitrary. The operating program suggests
a combination of station number and station name.

How to export a configuration (OTT Hydras 3)

This export type is required to transfer an OTT ecolog 500 (3G) configuration to
the OTT Hydras 3 user software. This "+ XML" file is read in via the Hydras 3
function "File", "Import Station Configuration (XML)".

From the "File" menu, select the "Export Hydras 3 (XML)" function.

In the "OTT ecolog 500 (3G) — XML configuration" window, check the file
name, select the storage location, and click "Store" — The operating program
saves the configuration in a "+ XML" file.

Note

The file name of the "+ XML" file is arbitrary. To avoid affecting later data
transfer, it should not be changed. The operating program proposes a combi-
nation of station number and station name along with the ending

"x STATION.XML".

How to import a configuration

From the "File" menu, select the "Import configuration" function.

For an already opened configuration, confirm "Ignore changes?" message by
clicking "Yes" (if necessary, save configuration in advance).

In the "OTT ecolog 500 (3G) configuration import" window, select the appro-
priate "*.BIN" file and click "Open" — The operating program reads in the
configuration from the *.BIN" file. (Prior o this, save any configuration that is
already open).

Note

The factory default configuration is found on the "OTT Water Logger Software"
CD-ROM.
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10 Determining and displaying instantaneous values
(Observer function)

For determining and displaying instantaneous values, the operating program
includes a so-called "Observer". The Observer also allows a manually determined
measured value, e.g. contact gauge value, to be entered into the datalogger
(Observer registration).

Various options can be set concerning the observer:

Options in the start window of the operating program:

— Directly and exclusively opening the Observer, or

— Opening of a window fo set the operating parameters

Effect of an optionally entered Observer registration (pressure sensor):

— The Observer registration is only used as a check value or

— the Observer registration leads to a value change (set offset)

Suppress the display of the instantaneous value (pressure sensor) prior to
entering an observer registration.

As an dlternative to the following procedure, you may use a cellular phone to
show instantaneous values by SMS messages or to make observer entries. This
requires the "SMS info" feature to be enabled and set up. For more information,
please refer to online help in the operating program.

How to set the Observer options

Start the operating program.
From the "File " menu, select the "Options" function. (If the option dialog
cannot be called, a password must first be entered. Refer to Chapter 12.)
Enable the checkbox(es) of the required Observer option(s):
— /] Only observer mode
— [/ Do not calculate manual input value with scaling
(only check value/no value change);
— [/ Suppress display of instantaneous value before input;
Click the "OK" button.

Fig. 18: Input window to estoblish
options for the observer. = B
For further information on protecting [~ Advanced operation ...

the operating program by means of a
password refer to Chapter 14.

Pazsword I

r— Observer

I~ Only chserver mode
I~ Do not calculate manual input value with scaling

I~ Suppress display of instantaneous value before input

Ok |

The combination of "Only observer mode" and a password protects the operating
program against unauthorized input of operating parameters.

The "Advanced operation..." option displays an additional button in the window
for sefting the operating parameters.



Fig. 19: Display/input window "OTT Water
Logger Operating Program — Observer".

The window displays the current
instantaneous value for all measurements.
Furthermore, the window displays the sensor
number/name, the current battery voltage,
the amount of power used from the batteries
up to now, and the date and time.

How to open the Observer function

Start the operating program.

Establish the PC/OTT ecolog 500 (3G) communication link, refer to Chapters
9.20r93.

Depending on the option set: In the start window of the operating program,
either select "View Instantaneous values" or "Setup device" and in the sub-
sequent window, select the "View Instantaneous values" function in the "OTT
ecolog 500 (3G)" menu — The OTT ecolog 500 (3G) starts an instantaneous
value measurement and the "Observer" window opens:

mDTT Water Logger Operating Program - Observer E

ecolog 500/ 00000004 36V /S1E14 AR 01.11.2011 09:31:43

Lewel /0001 |4.SDD 4420 m
Obszerver registration with value change

Temperature / 0002 107 i

U Bat / 0003 36 W

Stare Refresh Exit

™ Automatic refresh

If necessary: Input Observer registration into the entry field of the pressure sen-
sor and click on the "Store" button.

If necessary: Start new instantaneous value measurement: click on the "Refresh"
bution ("] Automatic refresh” starts an instantaneous value measurement
every 5 seconds).

Exiting the Observer: Click the "Exit" button and close the operating program.

Notes

The OTT ecolog 500 (3G) stores each call of the Observer function in an info
channel with date and time. After reading in and accepting into the OTT
Hydras 3 user software, this information can be displayed in the evaluation
window of a sensor using the "Info Data" > "Station" > Displays" function
("Observer registration general"). Similarly, they are visible via the "View
data" > "Table" function of the operating program.

If the "[7] Do not calculate manual input value with scaling" check box in the
"Options" window is enabled, the OTT ecolog 500 (3G) also saves the input
check value as well as the current instantaneous value. After reading in and
accepting into the OTT Hydras 3 user software, this information can be dis-
played in the evaluation window of a sensor using the "Info Data" > "Sensor"
> "Displays" function ("Observer registration with check value). Similarly, they
are visible via the "View data" > "Table" function of the operating program.
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11 Reading data

How to read data (on site)

Start the operating program.

Establish the PC/OTT ecolog 500 (3G) communication link, refer to Chapters
9.2 0r9.3.

Press the "Download data" button in the start window — The operating pro-
gram displays the available sensors and the possible period for downloading
in the "Download data" window. If these values are not visible: Press the
"Connect" button.

Select the desired sensors or "All sensors".

Select the desired read period or "All". (The row above the entry field shows
the complete time period for which there are data.)

Click the "Connect" button — The operating program copies the measured
values from the OTT ecolog 500 (3G) to the PC. The data is then available in
the raw data directory of the operating program.

If necessary: Change to the "View / Export data" function to display/export
measured values and/or to export to another software application.

Click the "Main menu" button.

Flg 20 Downloading deG, BB OTT Water Logger Operating Program - Download data _ O] x|
File Help

0000070457 [OTT ecolag 500

vl 0001
nooz
0003

All senzors
02/02/2071 0141172011

|28f02f2011 | Tl IUM’H:’ZUH ~

Dowrload data | Cancel |

Wiew / Ewport data |

OTT Qipheus Mini # OTT CTD / OTT ecolog
D& - OTT DucLink =
Connect M air meriu
COM1: =] |57600 =

Possible alternatives for downloads:

Using the operating program and a cellular network

(OTT ecolog 500)

In conjunction with a modem connected to the PC, a communication link may
be established via a cellular network (read data remotely), refer to online help.
Note: A remote communication connection can only be established with the

OTT ecolog 500 (not the OTT ecolog 500 3G)!

Using the "OTT Hydras 3 (Basic)" application software

From the tree, select the desired station by double clicking it. In the following
window, make the necessary seftings and click the "Start" button. For further
information, see the online help for the OTT Hydras 3 (Basic).




12 Exporting data

After downloading to the operating program, the measured value and information
data can be found in the "RAWDATA" sub-directory of the program directory
(default setting: "C:\Program files\OTT\OrpheusMini_CTD\RAWDATA"). To
transfer to an external application, you may export the data in various formats:

CSV - Structured text file in CSV format (Comma-Separated Values);
Excel — Microsoft Excel spreadsheet program;

OTT Hydras 3 - Raw data format for the OTT Hydras 3 user software;
OTT MIS - OTT-specific file format for automatically importing into the
measurement database of the OTT Hydras 3 user software.

Using the "Export options" dialog window, you may set the location for saving
and, for the CSV format, various export parameters. The data will remain avail-
able in the sub-directory after export. If required, you may explicitly delete it.

Info data can only be exported to the OTT Hydras 3 user software.

How to export the data
Step 1 - Make export settings:

Click the "View / Export data" button in the start window.

In the "View / Export data" window, click the "Export options" button, refer to
Fig. 21.

Set the path to the location of the required export format (default setting:
"C:\Program files\OTT\OrpheusMini_CTD\Export"). No path can be set for
the Excel format: The operating program automatically opens Microsoft Excel
during export and displays the data in a new workbook. For the "Hydras 3"
format, the "2" button can be used o automatically find the installation directory
of OTT Hydras 3.

For the "CSV" format: set "Field separator", "Dec. separator", "Date format",
and "Time format". For the date and time formats, the typical Windows place-
holders may be used.

Step 2 - Export data:

From the list, select the desired station/sensor (multiple selections possible).
Click the "Export ..." button.

Confirm the message about successful export by clicking "OK".

If required, delete the exported data: Click the "Delete" button.
(Station/sensor must still be selected.)

Confirm the message by clicking "Yes".
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Fig. 21: Viewing/exporting data.

13 Displaying data

After downloading to the operating program, the measured value and information
data can be found in the "RAWDATA" sub-directory of the program directory
(default setting: "C:\Program files\OTT\OrpheusMini_CTD\RAWDATA"). For an
initial check, you may display the data graphically and numerically and print
them, if required.

How to display data graphically

Click the "View / Export data" button in the start window.

From the list, select the desired station/sensor (multiple selections possible - a
maximum of é will be displayed; info data can only be displayed numerically).
Click the "Graphic" button — The operating program displays the window pre-
senting the graphical view of the selected data;

— Show ruler: "F12" function key. Move ruler: Arrow keys « —.

— Zoom in: Use the mouse to drag the desired area.

— Zoom out: "F12" function key.

Print graphic: From the "File" menu, select the "Print" function.

Close graphic: From the "File" menu, select the "Exit" function (or [<]).

How to display data numerically

Click the "View / Export data" button in the start window.

From the list, select the desired station/sensor (mu|tip|e selections possib|e, a

maximum of é will be displayed).

Click on the "Table" button — the operating program displays the window with

the numerical view of the data in the OTT data protocol;

— Only display measured values: select "Values".

— Highlight special areas (only with information data): Select "Observer &
operation", "Alarm & limit", "Communication & faults", "Faults & service
log".

Printing the numerical display: From the "File" menu, select the "Print" function.

Closing the numerical display: Select the "Exit" button (or [<]).

How to delete data

From the list, select the desired station/sensor (multiple selections possible).
Click the "Delete" button.
Confirm the message by clicking "Yes".

EUTT Water Logger Operating Program - Yiew / Export data - [C1f x]
File  Help

Station FROM-Date
0000000457 fecolog 500)

01.01.2011 01.02.2011
0000070457 (ecolog 500) nooz 01.01.2011 07.11.2011 Graph |
0000070457 (ecolog 500) ooos 01.01.2011 01.11.2011

0000070457 (ecolog 500) INFO 01.01.2011 01.11.2011 Table |
Delete |

Export C5W |
Expart Excel |
Export OTT MIS |
Expot Hypdras 3 |

Expart Options |

Mair meri [




14 Protecting the OTT ecolLog 500 (3G) unit and the
OTT Water Logger Operating Program using a
password

To prevent unauthorized input of operating parameters, you may protect

the OTT ecolog 500 (3G) unit and/or
the operating program:

using a separate password for each.

How to protect the operating program using a password

Start the operating program.

From the "File" menu, select the "Options" function.

Enter an eight-digit (max.) password into the "Password" input box. Allowed
characters 0 ... 9, A ... Z. (This password is independent of the

OTT ecolog 500 (3G) password.)

Enable the "Only observer mode" check box.

Click the "OK" button.

Close the operating program — The operating program is now protected: The
"Setup device" button in the start window is no longer visible.

Fig. 22: Profecing the opercling program
by means of a password — Input window — General

For defmlng a possword. ] e apei.

A password protected operating program is A [FesswoRD
reasonable only if the operating program
starts in Observer mode ("Only observer
mode" check box enabled)! IV Orly observer mods

I~ Do not calculate manual input value with scaling

r— Observer

I~ Suppress display of instantaneous value before input

Ok |

Please note:

If the password is lost, you can no longer configure or parameterize the
OTT ecolog 500 (3G) on this PC. If this occurs contact OTT HydroService.
The password assigned here only applies to the operating program installed
on this PC. The OTT ecolog 500 (3G) unit is not protected by this password!

How to unlock a password-protected operating program

Start the operating program.
From the "File" menu, select the "Options" function.
Enter the password into the "OTT ecolog 500 (3G)" window.

Fig. 23: Unlocking the operating program —

Password input window.
Enter password [0..9.4. 2]

(] 3 I Cancel
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Fig. 24: Protecting the OTT ecolog 500
by means of a password —
Input window for defining a password.

Fig. 25: Unlocking the
OTT ecolog 500 (3G) -

Password input window.

Click the "OK" button.

Disable the "Only observer mode" check box.

Remove the entry from the "Password" input box.

Click the "OK" button — The operating program is no longer password
protected.

How to protect the OTT ecoLog 500 (3G) using a password

Start the operating program.

Establish the PC/OTT ecolog 500 (3G) communication link, refer to Chapters
9.2 0r9.3.

Click the "Setup device" button in the start window.

Click the "Advanced operation ..." button.

(Button not visible2 — Enable the "Advanced operation ..." check box

in the "Options" function in the "File" menu.)

Click the "Connect" button.

From the tree view, select "Communication Interface".

Enter a password of maximum eight characters into the "OTT ecolog 500 (3G)
password" input box. Allowed characters 0 ... 9, A ... Z. (This password is
independent of the operating program password.)

Click the "Save to device" button.

Warning: "Reset OTT ecolog 500 (3G) and delete data memory additionally2"
Confirm by clicking "No" — The OTT ecolog 500 (3G) is now protected
against unauthorized operation.

[ Communication interface
General | Modem / 1TC | SMS data | GRPS data | SMS Info

Pazsword OTT ecolog 500 I

Please note: If the password is lost, you can no longer configure or parameter-
ize the OTT ecolog 500 (3G). If this occurs contact OTT HydroService.

How to unlock a password-protected OTT ecolog 500 (3G)

Start the operating program.

Establish the PC/OTT ecolog 500 (3G) communication link, refer to Chapters
9.20r9.3.

Click the "Setup device" button in the start window.

From the "OTT ecolog 500 (3G)" menu, select the "Enter password" function.
Enter password.

Click the "OK" button.

Confirm the "Password accepted! OTT ecolog 500 (3G) unlocked" message by
clicking "OK".

Click the "Connect" button — The operating program downloads the current
OTT ecolog 500 (3G) operating parameters.

OTT ecolog 500 E
Enter password [0..9.4. 2]

(] 3 I Cancel




Fig. 26: Setting the OTT ecolog 500 (3G)
date and time.

15 Setting date and time

The internal clock of the OTT ecolog 500 (3G) is a high-accuracy realtime-clock.
It runs as soon as batteries are installed in the OTT ecolog 500 (3G). After the
batteries are removed, the clock will continue to run for approximately 10 min-
utes. After a longer period of power loss, the OTT ecolog 500 (3G) will lose the
date and time. When batteries are reinstalled, the OTT ecolog 500 (3G) adopts
the date and time of the last stored measured value, with one minute added to the
stored time. The date and time are set using the operating program.

How to set the date and time

Start the operating program.

Establish the PC/OTT ecolog 500 (3G) communication link, refer to Chapters
9.20r9.3.

Click the "Setup device" button in the start window.

Select the "Date/time" function in the "OTT ecolog 500 (3G)" menu — The
operating program reads the date and time from the OTT ecolog 500 (3G)
and opens the "OTT ecolog 500 (3G) — date/time" window.

mDTT Water Logger Operating Program - Date / lime E

OTT ecolog 500 01/09/2011 09:35:43 Refresh |
FLC [DST) 01/09/20171 10:40:08 _
Exit |

If necessary: click the "Refresh" button — The OTT ecolog 500 (3G) reads the
date and time again.

If necessary: Adjust the desired values in the two input fields.

Click the "Set date/time" button — The operating program sets the

OTT ecolog 500 (3G) date and time to the PC time/date or to the values set.
Click the "Exit" button.

Please note: If the PC is in Daylight Saving Time (ID: PC (DST)), the operating
program automatically uses the standard time without DST correction. To obtain
continuous time series, it is a good idea not to use Daylight Saving Time in the
OTT ecolog 500 (3G).

In connection with a GPRS(/3G) remote data transfer and the "Time synchro-
nization" function, it is necessary to reference the time to UTC/GMT and to set the
time zone of the station in the "Advanced operation”, "OTT ecolog 500 (3G)"
window, refer to online help.

Note

When the unit is put back into service, it may be appropriate to erase the data
memory after having set date and time, refer to Chapter 16.
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16 Erasing the data memory

Please note: After erasing the data memory, the measured values stored in the
OTT ecolog 500 (3G) are permanently lost! If necessary download measured
values before erasing!

How to erase the data memory

Start the operating program.

Establish the PC/OTT ecolog 500 (3G) communication link, refer to Chapters
9.20r93.

Click the "Setup device" button in the start window.

Select the "Delete data memory" function in the "OTT ecolog 500 (3G)" menu.
Acknowledge the "Are you sure you want to delete data memory2" warning by
clicking "Yes"— The operating program erases the complete data memory of
the OTT ecolog 500 (3G) (all measurement channels including the info chan-
nel). The OTT ecolog 500 (3G) then determines and stores the water level and
the water temperature again using the sample interval settings set.

17 Updating the OTT ecolog 500 (3G) firmware

If required, you have the option of updating the OTT ecolog 500 (3G) firmware
(operating system software). This makes sense, if e.g. devices delivered at different
times are to receive the same operating system version. Updating is carried out
via the operating program. According to availability, an updated version of the
OTT ecolog 500 (3G) firmware can be found on the internet site "www.ott.com"
in the "myOTT" area.

How to update the firmware

Download the new version of the firmware (File: e.g. "5544630293_01035_-
el500NG.bin" or 5544830293_01000_el500NG.bin) from the internet site.
Move the file "5544630293_XXXXX_el500NG.bin" or "5544830293_XXXXX-
_el500NG.bin" to the directory, in which the operating program is located.
Establish the PC/OTT ecolog 500 (3G) communication link, refer to Chapters
9.2 0or 9.3.

From the "OTT ecolog 500 (3G)" menu, select the "Firmware update" function.
Confirm message by clicking "Yes" — The operating program copies the new
firmware to the OTT ecolog 500 (3G). The OTT ecolog 500 (3G) then deter-
mines and stores the water level and the water temperature again using the
sample inferval settings set.

Please note: During updating process, avoid breaking the communication
link (e.g. by accidentally removing the OTT Duolink from the infrared interface
of the OTT ecolog 500 (3G)). If the communication link is aborted, the
firmware will no longer be executable! Similarly, no other programs should be
started or files opened during the copying process!

Notes

If there are multiple ".bin" files in the directory you will have to select the
required file manually.

The measurements saved in the OTT ecolog 500 (3G) are not lost after an
update.



Fig. 27: Cleaning the pressure probe.

18 Maintenance work

18.1 Cleaning the pressure probe

Recommended interval: Every 12 months

In case of difficult local measuring conditions (heavy
deposits): as required every 4 to 6 months.
(Measurements that are inaccurate or not plausible indi-
cate a contaminated pressure sensor.)

How to clean the pressure probe

Open the top cap/observation well cover.

Completely remove the OTT ecolog 500 (3G) from the observation well.
Remove the black protective cap.

Clean the pressure sensor carefully using a brush and water. Lime scale
deposits can be removed using a common household scale remover. Make
sure to follow the use and safety instructions for the scale remover!

Rinse the pressure probe thoroughly with clear water!

Reattach the black protective cap.

Reinstall the OTT ecolog 500 (3G), refer to Chapter 8.

Determine current reference value by means of a contact gauge and enter it,
refer to Chapters 9.4 or 10.

Close the top cap/observation well cover.

Black
protective cap

Pressure probe
with datalogger

Pressure sensor
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Fig. 28: Replacing the pressure
probe desiccant capsule.

18.2 Replacing the desiccant capsules

Recommended interval: Depending on the level of air humidity at the station,
every 12 to 24 months and when replacing the batteries.
There is a humidity indicator on the desiccant capsule.
When this indicator changes its color from blue to pink
the desiccant capsule has to be replaced, irrespective of
the time elapsed.

Quantity: 2 (1x pressure compensation capillary, 1x communica-
tion unit).

Notes

Store the desiccant capsule only in its original packaging.
Use only desiccant capsules that are fitted with a blue humidity indicator.

How to replace the desiccant capsules
A) Desiccant capsule for pressure compensation capillary

Open the top cap/observation well cover.

Pull and hold the communication unit approximately 1 m out of the observation
well (a second person would be useful).

Remove the screw fitting from the communication unit.

Slide the cap and pipe casing of the communication unit approx. 50 cm
towards the pressure probe cable. (The rubber stop located on the pressure
probe cable (refer to Fig. 2) prevents the pipe casing from falling.)

Pull the desiccant capsule container of the pressure compensation capillary
from the holder, as shown in Fig. 28.

Remove the cap of the container by rotating it counter-clockwise.

Remove the exhausted desiccant capsule.

Install new desiccant capsule. Labeling must face towards pressure compen-
sation capillary.

Install the cap by rotating it clockwise.

Reinsert the container into the holder.

Container for  Pressure compensation capillary
desiccant capsule desiccant capsule Cap

Pressure compensation capillary




B) Desiccant capsule for communication unit

Remove the exhausted desiccant capsule of the communication unit, as shown

in Figure 29.
Install new desiccant capsule.

Fig. 29: Replacing the communication
unit desiccant capsule.

a—

40%

N,
\

—— Communication unit
desiccant capsule

Slide the pipe casing of the communication unit back up to the stop.

Please note: Do not bend or pinch the battery lead.
Reinstall the screw fitting to the communication unit.

Slowly and carefully reinsert the communication unit into the observation well.
Close the top cap/observation well cover.

18.3 Checking/replacing the batteries

Refer to Chapter 5.

45



19 Error messages

When faulty measurements or a malfunction occur, the OTT ecolog 500 (3G)
stores one of the following error messages in the data memory instead of a mea-
sured value.

Err 00  Internal error (automated measurement)
Err 01 Internal error (A/D conversion error)
Err 03  Measuring range exceeded
Err 10 Measured value (still) not recorded; ,Err 10” indicates measured
values that are missing from the database and that
— have not yet been recorded, or
— could not be determined due to a short-term, temporary fault (in-
dividual measured values). As these faults cannot be avoided in all
cases due to technical reasons, they may also occur occasionally
during regular operation.

Internal errors indicate a device fault, if they occur repeatedly.

20 Troubleshooting/remedy

No communication possible
(operating program/OTT ecolog 500 (3G))

Password programmed?
— Enter correct password.
Batteries installed?
— Install batteries.
Alkaline batteries (only OTT ecolog 500): Battery voltage lower than
approx. 1.9V
— Replace the batteries.
Lithium battery: Battery exhausted?
— Replace the battery.
Pressure probe cable damaged?
— Send OTT ecolog 500 (3G) to factory for repair.
Infrared interface dirty?
— Clean the infrared interface carefully using a damp, soft cloth.
Sefting measured value not possible?
— Scaling module missing. Check configuration
(for advanced operation, refer to online help).

Communication starts and then aborts.

Alkaline batteries (only OTT ecolog 500): Battery voltage lower than
approx. 1.9V

— Replace the batteries.

Lithium battery: Battery exhausted?

— Replace the battery.

Faulty measured values

Temperature values fc:uhy

— Check configuration? (for advanced operation, refer to online help).

Pressure sensor values faulty

— Check configuration” (for advanced operation, refer to online help).

— Check the pressure compensation capillary in the communication unit
(blocked?). Clean as necessary.

— Check pressure sensor for contamination. Clean as necessary.

1 The default factory configuration is located on the "OTT Water Logger Software" CD-ROM



No measured values in database

Configuration incorrect?

— Check configuration (for advanced operation, refer to online help).
Alkaline batteries (only OTT ecolog 500): Battery voltage lower than
approx. 1.9V

— Replace the batteries.

Lithium battery: Battery exhausted?

— Replace the battery.

Communication through cellular network not possible/
not successful

No transmission parameters (operator, etc) configured

— Check the operating parameters entered, refer to Chapter 9.4.

A remote communication connection cannot be established with the

OTT ecolog 500 3G

— this is not a malfunction. In a 3G cellular network (UMTS/HSPA+), this is no
longer possible for technical reasons. The circuit-switched service required for
this purpose, i.e. CSD (Circuit Switched Data) is no longer available in 3G cel-
lular networks.

Alkaline batteries (only OTT ecolog 500): Battery voltage lower than

approx. 1.9V

— Replace the batteries.

Lithium battery: Battery exhausted?

— Replace the batteries.

SIM card missing

— Insert the SIM card, refer to Chapter 6.

Incorrect PIN

— Check PIN, refer to Chapter 9.4.

GSM signal too low

— Check whether an external radio antenna should be used, refer to
Chapter 7.

No measured values present (by transmitting data)

— Wait for the next data inferval.

1) The default factory configuration is located on the "OTT Water Logger Software" CD-ROM.
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21 Repair

In case of a device malfunction, use Chapter 20, Troubleshooting/remedy to
see if you can resolve the problem yourself.
In case of device failure, please contact the OTT repair center.

OTT Hydromet GmbH
Repaircenter

LudwigstrafBe 16

87437 Kempten - Germany
Phone +49 831 5617-433
Fax  +49 831 5617-439
repair@ott.com

Please note: Have a faulty OTT ecolog 500 (3G) checked and repaired only
by the OTT repair center. Never attempt to repair the unit yourself! Any repairs or
attempted repairs carried out by the customer will void any warranty.

22 Notes about the disposal of old units

Within the member countries of the European Union

In accordance with the European Union guideline 2002/96/EC, OTT takes back
old devices within the member countries of the European Union and disposes of

them in an appropriate way. The devices concerned by this are marked with the
symbol shown aside.

For further information on the return procedure, please contact your local sales
contact. You will find the addresses of all sales partners in the internet on
"www.ott.com". Please take into consideration also the national implementation

of the EU guideline 2002/96/EC of your country.

For all other countries
After putting the unit out of service, properly dispose of the OTT ecolog 500 (3G).
Observe the regulations applicable in your country for the disposal of
electronic devices.
Never dispose of the OTT ecolog 500 (3G) in the normal domestic waste.

Materials used
Refer to Chapter 23, Technical data.



23 Technical data

Water level
Measuring range

Resolution”

Accuracy (linearity + hysteresis)
Long-term stability (linearity + hysteresis)
Zero

Overload-resistant without permanent
mechanical damage (pressure sensor)

0...0.4 bar

0...1bar

0...2bar

0 ... 4 bar

0...10 bar
Units

Pressure sensor
Temperature-compensated operating range

Temperature
Measuring range
Resolution
Accuracy

Units

Power supply

Current consumption
Sleep mode
Read (IrDA)
Measuring operation
Mobile communication active, receiving
Mobile communication active, transmitting

Lifetime (1 hour sample interval, one transfer per day)

Lithium battery (26 Ah)
Lithium battery (13 Ah)
Alkaline batteries

Clock
Design
Accuracy
Buffer period for battery replacement

Interface
Cellular network modems/frequencies

OTT ecolog 500
OTT ecolog 500 3G
SIM card

OTT ecolog 500
OTT ecolog 500 3G

4 m water column (O ... 0.4 bar)
. 10 m water column (O ... 1 bar)
. 20 m water column (O ... 2 bar)
. 40 m water column (O ... 4 bar)
... 100 m water column (O ... 10 bar)
0.001 m; 0.1 cm; 0.01 ft; 0.1 inch
0.0001 bar; 0.001 psi
+0.05 % full scale
+ 0.1 %/a full scale
+ 0.1 % full scale

O O O oo

4 bar

10 bar

15 bar

25 bar

40 bar

m, ft, inch, bar, psi, pascal
ceramic; Iempercrure-compensored

-5°C ... +45 °C (ice free)

-25°C ... +70°C

0.1 °C (calibrated: 0.01°C)

+ 0.5 °C (calibrated: + 0.1 °C)
°C-°F

Lithium battery, D type, 3.6 V / 13 Ah; or
Lithium battery, DD type, 3.6 V / 26 Ah
2 x 1.5V dlkaline battery (C cell)?

100 pA
76 mA
40 mA
13 mA
160 mA

> 10 years minimum
> 5 years minimum

> 1 year minimum (high quality battery types).

Real-time clock
+1 minute/month (at +25 °C)
10 minutes max.

Infrared (IrDA)

GSM/GPRS

900/1800, 850/1900 MHz;

GSM/GPRS; UMTS/HSPA+

900/1800, 850/1900 MHz;

800/850, 900, AWS 1700, 1900, 2100 MHz
1.8/3V

Mini-SIM (UICC; 2FF)

Micro-SIM (Mini-UICC; 3FF)

1 for value ranges £32.750 m; £3275.0 cm; +327.50 ft; £3275.0 inch; £3.2750 bar; +32.750 psi

2 for OTT ecolog 500 (not suitable for OTT ecolog 500 3G)
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Radio anfenna

Temperature range, operating
Temperature range, storage

Air humidity

Data memory

Measurement memory

Number of measured values
Number of logical channels
Physical channels (input signals)

Sample inferval
Storage interval (mean interval)

Individually configurable functions

Mobile communications functions
SMS direct transmission

SMS command

Data retrieval via direct connection
GSM/GPRS functions

UMTS/HSPA+ functions

Mechanical Data
Can be installed in observation wells
— Top caps with cut-out (OTT, HT)
- With adapter plates for top caps
With cut-out (OTT, HT)
- With universal suspension brackets for top caps
Without cut-out/universal installation
Dimensions
Communication unit (L x &)
Pressure probe (L x &)
System length (cable length including
communication unit/pressure probe)
Weight
Communication unit (incl. lithium batteries, DD type)
Pressure probe
Pressure probe cable

50

Built-in, robust and weather-proof; optional connection of an exter-
nal antenna is possible (SMA connection); max. permitted antenna
gain (incl. cable): max. 2.5 dBi.

A minimum distance of 0.20 mefres must be maintained between the
radio antenna and people and between radio antenna and other
electrical equipment/antennae!

-30°C...+85°C

-40 °C ... +485°C

5% ... 95 % (non-condensing)

4 MB

Approx. 500,000

6 + 1 info channel

Water level/pressure

Temperature

Supply voltage

GSM signal strenght

Minimum supply voltage during transmission via cellular network
5 seconds ... 24 hours

5 seconds ... 24 hours

- Basic or advanced operation

- 5 extended sample intervals with start/stop time indication,
support for pumping tests

— Selection of units

- Number of decimal places

— Pressure/level measurement or depth measurement

- With consideration of the local gravitational acceleration

- Display of instantaneous values with level monitoring function

- Password protection

- Measured value processing: Calculation of mean; delta storage;
scaling function; extreme value storage; limit control of the sample
interval

- Virtual sensor/virtual terminal

- Alarm management

- Remote data transfer

OTT ecolog 500 3G
v
v

OTT ecolog 500

NSNS

v
4

2"
3"[ 4"’ 6"

> 2ll

520 mm x 50 mm
195 mm x 22 mm
2...200m 1 %+5cm

Approx. 1.0 kg
Approx. 0.300 kg
Approx. 0.082 kg/m



Material

Pressure probe housing POM, stainless steel 1.4539 (904 L)
Seals Viton
Separating membrane Al203 ceramics (96 %)
Cable jacket PUR
Communication unit housing Aluminum, PA-GF
Type of protection
Communication unit IP 67 (submersion depth 1 m, submersion duration 30 min)
Pressure probe IP 68
Desiccant 2 capsules (2.65 g silica gel), recommended replacement interval:

Once per year

Performance classification of the sensors
according to DIN EN 1SO 4373

Measurement reliability Performance class 1

Temperature range Temperature class 2

Relative air humidity Class 1

EU directives compliance the OTT ecolog 500 (3G) complies with the EU directives applicable

at the time of production; for details, see Declaration of Conformity
(www.ott.com/resources)

€

FCCID
OTT ecolog 500 RIZT56KT1
OTT ecolog 500 3G RIZHE?10
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Appendix A - Note on Declaration of Conformity

If necessary, you can download the current version of the Declaration of
Conformity for the OTT ecolog 500 (3G) from our website as a PDF file:
www.ott.com/resources”!
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